Excel Tutorial 2: Formatting Workbook Text and Data

Microsoft® Office® 2013
Objectives

• Change fonts, font style, and font color
• Add fill colors and a background image
• Create formulas to calculate sales data
• Apply Currency and Accounting formats and the Percent style
• Format dates and times
• Align, indent, and rotate cell contents
• Merge a group of cells
Objectives

• Use the AVERAGE function
• Apply cell styles
• Copy and paste formats with the Format Painter
• Find and replace text and formatting
• Change workbook themes
Objectives

• Highlight cells with conditional formats
• Format a worksheet for printing
• Set the print area, insert page breaks, add print titles, create headers and footers, and set margins
Visual Overview

You use the Font button to change the font of selected text or numbers.

Every font can be formatted with a font style, such as bold, italic, or underline.

You can format a text string within a cell in Edit mode.

A font is a set of characters that employ the same typeface, such as Arial, Times New Roman, and Courier.

You can merge, or combine, several cells into one cell. This content is merged and centered across the range A17:A20.

You can rotate content in a cell.

The Alignment group has buttons for setting the horizontal and vertical alignment, the orientation, indents, and text wrapping of text in a cell, as well as merging cells.

The Accounting format lines up numbers within a column by their currency symbol and decimal point; negative numbers are enclosed in parentheses.

The Percent style formats numbers as percentages with the % symbol after the number and no decimal places. You can change the number of decimal places that are displayed, as shown here.
# Worksheet Formatting

The Number group has buttons for formatting numbers in the Accounting format, Percent style, and Comma style, as well as changing the number of decimal places displayed.

A fill color is a background color that can be added to cells to help differentiate parts of a worksheet or highlight data.

You can increase or decrease the number of decimal places that are displayed in a value. These values show no decimal places.

The Comma style adds a thousands separator to numbers, adds two decimal places, and lines up values within a column by their decimal points. You can change the number of decimal places that are displayed, as shown here.
Formatting Cell Text

• **Formatting**
  – Process of changing workbook’s appearance by defining fonts, styles, colors, and graphical effects
    • Only the *appearance* of data changes, not data itself
      – Enhances readability and appeal
      – Live Preview shows the effects of formatting options before you apply them

• **Themes**
  – Named collections of formatting effects
Formatting Cell Text

• You can add formatting to a workbook by choosing its fonts, styles, colors, and decorative features through the use of themes.
  – A **theme** is a collection of formatting for text, colors, and graphical effects that are applied throughout a workbook to create a specific look and feel.
Formatting Cell Text

- As you format a workbook, **Galleries** and **Live Preview** show how a workbook would be affected by a formatting selection.
  
  – **Gallery** is a menu that shows a visual representation of the options available for the selected button.

  – **Live Preview** shows the results of clicking each option. By pointing to different options, you can quickly see different results before selecting the format you want.
Applying Fonts and Font Styles

- Theme fonts and non-theme fonts
- Character styles (**serif fonts** and **sans serif fonts**)
- Font styles, special effects, font size
Applying a Font Color

- Themes have 12 colors: 4 for text and backgrounds, 6 for accents and highlights, and 2 for hyperlinks
- Standard colors (always available)
- Custom colors
- Automatic colors

Figure 2-3 Font color gallery

- Live Preview of the Red font color
- Big Red Wraps
- 10 theme colors (each with five variations)
- Standard colors available in all themes
- Pointer on the Red font color
Working with Colors and Backgrounds

• Changing a fill color

Figure 2-6  Font and fill colors in the Documentation sheet

- width of column B is 30 characters
- labels are white text on a red background
- red text on a white background
- text wrapped in the cell
Working with Colors and Backgrounds

- Background images do not print

New Perspectives on Microsoft Excel 2013
Changing a Fill Color

• Select the range you wish to apply a fill color to

• On the Home tab, in the Font group, click the Fill Color button arrow, and then click the specific color you wish to use in the Standard Colors section.
Adding a Background Image

• On the ribbon, click the Page Layout tab to display the page layout options.
• In the Page Setup group, click the Background button.
• Click the Browse button. The Sheet Background dialog box opens allowing you to navigate to the file location.
• Click the file, and then click Insert. The image is added to the background.
Using Functions and Formulas

- A primary feature of Excel is the ability to easily perform many mathematical and statistical calculations through functions and formulas.
- A function is a formula pre-established by Excel.
- A formula is created by the Excel user as needed.
Tutorial 2 Functions and Formulas

• The following formulas will be calculated in Tutorial 2

  – **Sales**—the total amount of sales at all of the restaurants
  
  – **Cost of Sales**—the cost of producing the store’s menu items
  
  – **Operating Expenses**—the cost of running the stores including the employment and insurance costs
Tutorial 2 Functions and Formulas

• The following additional formulas will also be calculated in Tutorial 2
  – Net Profit/Loss—the difference between the income from the gross sales and the total cost of sales and operating expenses
  – Units Sold—the total number of menu items sold by the company during the year
  – Customers Served—the total number of customers served by the company during the year
Formatting Numbers

• Goal: Make workbook easier to interpret
  – Change the number of digits displayed to the right of the decimal point
  – Add a comma as a thousands separator
  – Control number of decimal places
  – Use percentage and currency symbols
Formatting Calculated Values

• Create formulas to add, subtract, and divide values

Figure 2-8  Sales statistics for the entire company and per store

- Overall store sales statistics
- Per-store sales statistics are calculated by dividing the overall statistics by the number of stores
- Number of stores in 2014 and 2015
Formatting Calculated Values

• Applying number formats
  – Use **General number format** for simple calculations
  – Apply Excel’s additional formatting to make numbers easier to interpret

• Accounting style
  – Lines up currency values within a column by currency symbol and decimal point
  – Encloses negative numbers within parentheses
## Applying Number Formats

### Figure 2-11  Currency and Accounting number formats

<table>
<thead>
<tr>
<th>Currency Format</th>
<th>Accounting Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>$95,000.00</td>
<td>$ 95,000.00</td>
</tr>
<tr>
<td>-$3,300.00</td>
<td>$(3,300.00)</td>
</tr>
<tr>
<td>$0.00</td>
<td>$</td>
</tr>
<tr>
<td>$1,108.00</td>
<td>$ 1,108.00</td>
</tr>
</tbody>
</table>

- Negative values displayed with a negative sign
- $ symbols placed to the left of the leading digit
- Negative values displayed in parentheses
- Zeros displayed with a dash
- $ symbols fixed on the left edge of the cell
- Values slightly indented from the right cell edge

---

**New Perspectives on Microsoft Excel 2013**
Applying Number Formats

Figure 2-12  Formatted gross sales values

Accounting Format button

gross sales values displayed in the Accounting format with no decimal places

Increase Decimal button

Decrease Decimal button
Formatting Calculated Values

- Formatting dates and times
  - Dates/times are stored as numbers, not as text
    - Applying different formats does not affect values
    - Makes it easier to calculate time intervals
      - Short Date format or Long Date format
      - 12- or 24-hour time
Formatting Dates and Times

- Excel provides many formats for dates and times in the worksheets depending on user requirements
  - Select the cell in which the date and time should appear
  - On the ribbon, select the HOME tab
  - In the Number group, click the Number Format button arrow to display a list of number formats, and then select the preferred format.
  - The date is displayed with the selected format.
Formatting Worksheet Cells

• Format appearance of individual cells by:
  – Modifying alignment of text within the cell
  – Indenting cell text
  – Adding borders of different styles and colors to individual cells or ranges
Formatting Worksheet Cells

- Aligning cell content
  - Default:
    - Cell text aligned with left bottom borders
    - Cell values aligned with right bottom borders
  - Buttons to set alignment options are in Alignment group on Home tab

### Alignment buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="button.png" alt="Top Align" /></td>
<td>Top Align</td>
<td>Aligns the cell content with the cell’s top edge</td>
</tr>
<tr>
<td><img src="button.png" alt="Middle Align" /></td>
<td>Middle Align</td>
<td>Vertically centers the cell content within the cell</td>
</tr>
<tr>
<td><img src="button.png" alt="Bottom Align" /></td>
<td>Bottom Align</td>
<td>Aligns the cell content with the cell’s bottom edge</td>
</tr>
<tr>
<td><img src="button.png" alt="Align Left" /></td>
<td>Align Left</td>
<td>Aligns the cell content with the cell’s left edge</td>
</tr>
<tr>
<td><img src="button.png" alt="Center" /></td>
<td>Center</td>
<td>Horizontally centers the cell content within the cell</td>
</tr>
<tr>
<td><img src="button.png" alt="Align Right" /></td>
<td>Align Right</td>
<td>Aligns the cell content with the cell’s right edge</td>
</tr>
<tr>
<td><img src="button.png" alt="Decrease Indent" /></td>
<td>Decrease Indent</td>
<td>Decreases the size of the indentation used in the cell</td>
</tr>
<tr>
<td><img src="button.png" alt="Increase Indent" /></td>
<td>Increase Indent</td>
<td>Increases the size of the indentation used in the cell</td>
</tr>
<tr>
<td><img src="button.png" alt="Orientation" /></td>
<td>Orientation</td>
<td>Rotates the cell content to any angle within the cell</td>
</tr>
<tr>
<td><img src="button.png" alt="Wrap Text" /></td>
<td>Wrap Text</td>
<td>Forces the cell text to wrap within the cell borders</td>
</tr>
<tr>
<td><img src="button.png" alt="Merge &amp; Center" /></td>
<td>Merge &amp; Center</td>
<td>Merges the selected cells into a single cell</td>
</tr>
</tbody>
</table>

© 2014 Cengage Learning
Formatting Worksheet Cells

- Indenting cell content
  - Useful for entries considered subsections of a worksheet

Figure 2-16  Worksheet with formatted cells
Formatting Worksheet Cells

• Merging cells
  – Retains only content (and cell reference) from upper-left cell in the range
  – Merge options: Merge & Center, Merge Across, Merge Cell, and Unmerge Cells

![Merged cells example](image)
Formatting Worksheet Cells

- Rotating cell contents saves space and provides visual interest

![Figure 2-19 Rotated cell content](image-url)
Format Worksheet Cells

• Adding cell borders enhances readability of rows and columns or data
  – Add borders to left, top, right, or bottom of cell or range; around an entire cell; or around outside edges of a range
  – Specify thickness and number of lines in border
Format Cells Dialog Box Options

- Presents formats available from Home tab in a different way and provides more choices
- Six tabs, each focusing on different options:
  - Number
  - Alignment
  - Font
  - Border
  - Fill
  - Protection

Figure 2-20  Font tab in the Format Cells dialog box
Options in the Format Cells Dialog Box

- Border tab

**Figure 2-21** Border tab in the Format Cells dialog box
Session 2.2 Visual Overview

The PAGE LAYOUT tab has options for setting how the worksheet will print.

The Format Painter copies and pastes formatting from one cell or range to another without duplicating any data.

Print titles are rows and columns that are included on every page of the printout. In this case, the text in rows 1 and 2 will print on every page.

A manual page break is one you set to indicate where a new page of the printout should start and is identified by a solid blue line.

The Find and Replace commands, which are available from the Find & Select button, are used to quickly make content and format changes throughout a workbook.

The print area is a range or ranges in a worksheet that you specify to be printed. In Page Break Preview, the print area is not grayed out.

Cell styles contain predefined formatting options that can be applied to cells in the workbook.

Cell highlighting is a conditional format that changes a cell's font color or fill color based on the cell's value.

An automatic page break is set by Excel when the page of the printout is full and is identified by a dotted blue line.

Page Break Preview shows the location of the print area and all page breaks.
Using the Average Function

• As mentioned previously, Excel includes pre-determined formulas called functions.

• The **AVERAGE function** calculates the average value from a collection of numbers.
  – The syntax of the Average function is:
    \[
    \text{AVERAGE}\ (number1, \ number2, \ number3, \ ...)
    \]
Using the Average Function

Figure 2-23  AVERAGE function results

average gross sales for each store per month

average gross sales for all stores per month
Applying Cell Styles

• Use styles to ensure that cells displaying same type of data use the same format

• Style
  – Selection of formatting options using a specific font and color from the current theme
  – If style is later revised, appearance of any cell formatted with that style is updated automatically; saves time and effort
Applying Cell Styles

Figure 2-24 Cell Styles gallery

- Gallery of styles
- Pointer on the Heading 1 cell style in the gallery
- Live Preview of the Heading 1 cell style
Copying and Pasting Formats

• Copying formats with Format Painter
  – Fast and efficient way of maintaining a consistent look and feel throughout a workbook
  – Copies formatting without duplicating data
Copying and Pasting Formats

• Use Paste Options Button to paste formatting from a copied range along with its contents
Copying and Pasting Formats

• Use Paste Special to control exactly how to paste the copied range

![Paste Special dialog box](image-url)

- Specifies what to paste
- Applies the specified arithmetic operation to the copied value
- Avoids pasting into empty cells
- Pastes column data into a row or row data into a column
Finding and Replacing Text

• The Find and Replace commands let you make content and design changes to a Worksheet or the entire workbook quickly.

• The Find command searches through the current worksheet or workbook for the content or formatting you want to locate.

• The Replace command then substitutes it with the new content or formatting you specify.
Finding and Replacing Text

Figure 2-30  Find and Replace dialog box

- search text
- replacement text
- replaces every occurrence
- replaces the current occurrence
- highlights all occurrences
- locates the next occurrence
Working with Themes

• Appearance of fonts, colors, and cell styles depends on workbook’s current theme
• If theme is changed, formatting of fonts, colors, and cell styles changes throughout entire workbook
• Only elements directly tied to a theme change when you select a different theme
Working with Themes

Figure 2-32 Live Preview of the Organic theme

Themes button

pointer on the Organic theme in the Themes gallery

body font and Accent3 cell style as they appear in the Organic theme
Highlighting Cells with Conditional Formats

• Goal of highlighting: Provide strong visual clue of important data or results
• Format applied to a cell depends upon value or content of the cell
• Dynamic: If cell’s value changes, cell’s format also changes as needed
• Excel has four conditional formats: data bars, highlighting, color scales, and icon sets
Highlighting Rules

- Each conditional format has a set of rules that define how formatting should be applied and under what conditions format will be changed.

<table>
<thead>
<tr>
<th>Rule</th>
<th>Highlights Cell Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greater Than</td>
<td>Greater than a specified number</td>
</tr>
<tr>
<td>Less Than</td>
<td>Less than a specified number</td>
</tr>
<tr>
<td>Between</td>
<td>Between two specified numbers</td>
</tr>
<tr>
<td>Equal To</td>
<td>Equal to a specified number</td>
</tr>
<tr>
<td>Text that Contains</td>
<td>That contain specified text</td>
</tr>
<tr>
<td>A Date Occurring</td>
<td>That contain a specified date</td>
</tr>
<tr>
<td>Duplicate Values</td>
<td>That contain duplicate or unique values</td>
</tr>
</tbody>
</table>

Figure 2-33 Highlight Cells rules

© 2014 Cengage Learning
Highlighting Cells with Conditional Formats

Figure 2-34  Live Preview of the Less Than conditional format

- Negative values displayed in a red font
- Conditional Formatting button
- Finds cells whose value is less than 0
- Formats cells that meet the criteria in a red font
Highlighting Cells with Conditional Formats

• Always include a **legend** – a key that shows each color used in the worksheet and what it means

*Figure 2-37: Conditional formatting legend*
Formatting the Worksheet for Printing

• Print options can be applied to an entire workbook or to individual sheets

• Look at a worksheet in Page Layout view to see how it would print
Formatting the Worksheet for Printing

• Defining the **print area** allows you to override default settings and print part of a worksheet
  – Region sent to the printer from the active sheet
  – Can cover adjacent or nonadjacent range in current worksheet
  – Generally easiest to set in Page Break Preview

• Fit a large worksheet on a single page by reducing size of the page margin
Formatting the Worksheet for Printing

- Inserting page breaks
  - Automatic page breaks
  - Manual page breaks

Figure 2-39  Print area set for the Sales Report worksheet

- range A1:F24 prints on its own page
- solid line indicates a manual page break
- dotted lines indicate automatic page breaks
- print area covers the nonadjacent range A1:F24;A25:P49
Formatting the Worksheet for Printing

• Add print titles (descriptive information) on each page of a printout in case pages become separated

Figure 2-42  Print titles on page 3 of the Sales Report worksheet
Formatting the Worksheet for Printing

• Create page headers and footers to include text not usually found within the worksheet (e.g., author, date, filename)
• Headers and footers have three sections: left, center, right
• Elements are dynamic